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This instruction manual describes how to operate the HH83 Thermo-Collector.

� Intended Readers
This manual is primarily intended for two groups of readers: “operators” who actually mea-
sure temperatures with this Thermo-Collector and, “engineers” who are qualified to perform
setup and data processing operations for this instrument.

� Structure of the manual
This manual is organized into the following four parts:

� Information Required before Use
This part explains basic information, including the names and functions of each component
of this instrument and how to input characters, etc. Read this part before using this instru-
ment.

� Preparation for Measurement
This part explains “Thermo-Collector” software and how to perform setup. This part must be
read before starting preparation for temperature measurement.

� Temperature Measurement
This part explains the major operations required to actually measure temperatures. Read this
part before commencing temperature measurement.

� Utilizing the Measurement Data
This part explains the procedures for outputting the data measured with this instrument to a
personal computer or printer. Read this part to use or analyze the data measured with this
instrument.

� Checking contents of the package
Perform a visual check on the Thermo-Collector to make sure it is not damaged.
In addition, make sure that the following items have been supplied. If any of the items are
missing, please contact the dealer where this product was purchased.
Keep this box in case this product needs to be returned.

Item name Quantity
HH83 Thermo-Collector 1
“Thermo-Collector” software installer FD 2
LR6 alkaline dry cell 2
Dust-proof seal (for sealing screw holes on the back of the main unit) 2
Instruction Manual (this document) 1
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� Precautions required for safe use

� About this manual
• Read this manual to gain a thorough understanding of this instrument before operating it.
• This manual only describes the functions of this product and is not intended to guarantee

the applicability of this product to user’s particular purpose.
• This manual shall not be reproduced or copied in part or in whole without our permission.
• The contents of this manual may be subject to change without notice.
• Should the user find any errors, or unclear or missing sections in this document, contact the

dealer where this product was purchased.

� Disassembly or retrofit
Do not disassemble or retrofit this instrument. Only qualified service personnel are autho-
rized to disassemble and service the main unit.

� Precautions on handling
• Only parts and consumables specified by Omega should be used in this product.
• Do not store this instrument in a location where it will be subject to direct sunlight or high

temperatures, otherwise it may be discolored or deformed.

� Notes on protection and safety of this product
• Follow the safety instructions of this manual when handling the main unit or accessories to

be connected to the main unit.  If the main unit or accessories are not handled as specified
in this manual, we cannot guarantee the safety of this product.

• The “  Warning” mark that appears on the back of the main unit indicates the precautions
that must be observed when handling this instrument.  Refer to this manual for information
about how to operate this instrument.

• Throughout this manual the following safety conventions are used.

Warning

Used if the operator is at risk of being severely injured or killed.

Caution

Used if the operator is at risk of being injured or if the instrument may be damaged.

Note

Used to draw attention to important information about handling the instrument or use-
ful information about the operations and functions of this instrument.

[TIP]

Contains information supplementary to the main text.
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See Also
Provides a reference to related topics in this document.

� Precautions for handling components
Always observe the following precautions to avoid operator injury and damage to the equip-
ment.

� Probe

Warning

Do not point the tip of a needle-type standard probe or needle-type high-speed probe
at another person.  The tip of the needle is very sharp and can cause injury.

Caution

• Do not touch the stylus (metal) of a probe which has just measured a hot object.  A
hot stylus can cause a burn.

• Do not use a worn or damaged probe.  Such probes cannot measure temperatures
correctly.

• Before removing the probe from the main unit, pull the probe away from the object
to be measured.

• If a needle-type standard probe or needle-type high-speed probe is used, stick it
into a measuring object half the dimension of the probe’s stylus (metal).  If it is stuck
in too deeply, the operator may be burnt due to heat transfer to the probe grip.  Also,
the probe itself may be damaged.

• The probe grip and the cable connected to the main unit must be maintained at a
temperature between -20�C and 50�C. They have a small heat resistance, unlike the
stylus (metal) of the probe.

� Battery

Caution

If this instrument will not be used for a long period, remove the battery from the main
unit.  Otherwise, the battery liquid may leak and damage the main unit or cause it to
malfunction.

� Exemptions
• We do not guarantee this product in any way, except as set forth in the terms and conditions

of the certificate.
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• We shall not be liable for any consequent or inconsequent damages to the customer or a
third party arising from the use of this product due to any defect in materials or workman-
ship beyond our control.

� About the conventions used in the figures in this document
For understanding, figures in this document may be highlighted or simplified, or may have
portions omitted.

� Care of the main unit
• If there is a need to clean the main unit, wipe the surfaces with a wrung wet cloth.
• Use a cloth dampened with diluted neutral detergent to remove tough stains.  Only use

neutral detergents.  Do not use solvents or other detergents or chemicals.  They may dam-
age the main unit.

• Keep connectors, etc., dry.  Otherwise, the main unit may be damaged.

� Maintenance
If the main unit needs to be serviced, contact Omega.

� Trademark
• “Microsoft”, “Windows”, and “Excel” are the trademarks or registered trademarks of

Microsoft Corporation.
• Corporate names and product names that appear in this document are the trademarks or

registered trademarks of their owners.
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1 Features of This Product

This product is a handy-type thermometer that can measure a temperature and
make a record of it. It has a “collector function” to record the measured tempera-
tures and measurement conditions under the specified tag, and a “logging func-
tion” to automatically measure and record temperatures at given intervals.
This section outlines each function.

� Collector function
The collector function is used when the measured temperature and measurement conditions
are recorded under the specified “tag”.
In the “tag”, the tag name (i.e. “what”), date and time (i.e. “when”), operator name (i.e. “who”),
and alarm (i.e. “judgment on the measured data”) are recorded as the measurement condi-
tions, in addition to the measured temperature.

[Burger]

Printout of image from a recommended printer

HiAlarm=+80.0 LoAlarm=+60.0

No. Date Temp. Hi

00001 98/11/12/11:37:01 56.0

00002 98/11/12/11:37:01 57.5

00003 98/11/12/11:37:02 58.5

00004 98/11/12/11:37:03 59.8

00005 98/11/12/11:37:04 61.2

00006 98/11/12/11:37:04 62.0

00007 98/11/12/11:37:05 62.0

00008 98/11/12/11:37:06 70.0

00009 98/11/12/11:37:06 75.0

00010 98/11/12/11:37:07 81.0

00011 98/11/12/11:37:07 82.0

OK

OK

OK

OK

OK

OK

OK

OK

OK

NG

NG

Lo Person

Smith

Smith

Smith

Smith

Smith

Smith

Smith

Smith

Smith

Smith

Smith

NG

NG

NG

NG

OK

OK

OK

OK

OK

OK

OK

Tag name ("what")

Measurement temperature

Operator name ("who")

Date and time ("when")

Alarm
("measured data judgment")

NG = No Good

It is possible to use maximum 50 tags, and in these 50 tags, a total of 5,000 pieces of tempera-
ture measurement data can be recorded.  However, the more the data is saved with the logging
function, the less number of measurements can be made with the collector function.

Set up the following tag items in advance to use the collector function.
• Tag name
• Input channel
• Alarm
• Operator name

See Also
For more information, refer to the “Preparation for Measurement” part.

1  Features of This Product
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� Logging function
The logging function is used to automatically measure temperatures at given measurement
intervals and to continue to record the result data.  This function is useful when a temperature
variation within a certain period of time (e.g. temperature variation in a refrigerator being
transported) needs to be recorded.
With this logging function, the temperatures and date (year/month/day) and time will be re-
corded as a “log”.  Unlike the collector function, the logging function does not record the
operator name and alarm (measured data judgment).

[Convey  ] Interval=00:00:10

No. Date Temp.

00001 00/00/00/00:00:00 -10.5

00002 00/00/00/00:00:10 -10.5

00003 00/00/00/00:00:20 -11.0

00004 00/00/00/00:00:30 -12.0

00005 00/00/00/00:00:40 -11.5

00006 00/00/00/00:00:50 -11.0

00007 00/00/00/00:01:00 -11.0

00008 00/00/00/00:01:10 -10.7

00009 00/00/00/00:01:20 -10.5

00010 00/00/00/00:01:30 -11.0

00011 00/00/00/00:01:40 -12.0

Printout of image from a recommended printer

Log name

Date and time

Temperature

Measurement interval

It is possible to use maximum 10 logs, and in these 10 logs, a total of 20,000 pieces of data
can be recorded.  However, the more the data is saved with the collector function, the less
number of measurements can be made with the logging function.

Set up the following items in advance to use the logging function.
• Log name
• Input channel
• Measurement interval
• Measurement period

See Also
For more information, refer to the “Preparation for Measurement” part.

1  Features of This Product
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2 Names and Functions of Each Part

2  Names and Functions of Each Part

1 External probe connection jack (channel A)
Used to connect a needle-type standard probe, a

needle-type high-speed probe, or other probes.

2 Radiation temperature probe connec-
tion jack (channel D)
Used to connect a radiation thermometer.

3 RS-232C communication connection
terminal
Used to output data from this instrument to a per-

sonal computer or printer.

4 Built-in sensor (channel C)
Used to measure the external temperature.

5 Display (LCD)
Displays Thermo-Collector conditions, various setup

information, measurement temperature, etc.

6 [CH] key
Used to switch the current input channel.  Available

input channels include channel A (for probes), chan-

nel C (for the built-in sensor), and channel D (for the

radiation temperature probe).

7 [ESC] key
Used to cancel the previous operation and return to

the previous screen.

8 [Memory] key
Used to commence a temperature measurement with

either the collector function or the logging function.

9 [�] [�] key
Used to select an appropriate tag, log, or function.

10 [LOGGING] key
Used to switch between the collector and logging

functions.  Also used to modify alphanumeric char-

acters from uppercase to lowercase.

11 [POWER] key
Used to turn the power supply on and off.

12 [Set] key
Used to make the setup contents valid for operation.

13 [Func] key
Used to set up the selected function.

Also used to delete the measurement data.

14 [1],...,[9], and [0] keys
Used to enter alphabets and numbers.
The [0] key is also used for switching the unit of tem-
perature display.  If, for example, this [0] key is
pressed in the Home screen, the unit is switched to
“�F”. Another pressing of the same key will restore
the unit to “�C”.

15 [<] and [>] keys
Used to retrieve the logged tag data or log data, or to

select the character input position.

16 Battery compartment
Accommodates two LR6 alkaline dry cells.

17 Name plate



44

3 Setting the Battery

Two LR6 alkaline dry cells are included with this instrument.

1. Open the battery compartment cover at the back of the main unit.

See Also
For information about the position of the battery compartment, refer to “2 Names and Functions of
Each Part”.

2. Observing the correct polarity, install the two LR6 alkaline dry cells in the battery com-
partment.

Caution

Observe the correct polarity when installing the batteries in the battery compartment.
The main unit may be damaged if the batteries are installed incorrectly.

3. Close the battery compartment cover.

-End of procedure-

Caution

Remove old batteries from the compartment.  Battery liquid leakage may cause the
main unit to malfunction or may damage it. A “BatteryEmpty” message will appear on
the LCD shortly before the battery life expires.  When this message appears, replace
the batteries.

3  Setting the Battery
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4 Turn ON/OFF of the Power Supply

� Turn the power supply to ON

Press the [POWER] key.
After the “Ver. 1.00”, “Initial Test”, and “Initial OK” messages have been displayed, the time display screen appears
on the LCD.

19:13:15
– – – – – – – –

The power of the main unit is turned on.

� Turn the power supply to OFF

Hold down the [POWER] key for about three seconds.
The power to the main unit will be shut down after a short beep has been sounded.

4  Turn ON/OFF of the Power Supply
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5 Screen (LCD) Displays

12:30:00
+ 0 2 8 . 5 � C

➈

➅
➄

➇
➆

➁

➂

➃

➀

10

11

12

1 Indicates that the chime function is being set.

2 Indicates whether the current mode is the collector mode or logging mode.  If LOG is
displayed, the current mode is the logging mode.  If it is not displayed, the cur-
rent mode is the collector mode.

3 Indicates the input channels currently used for measurement.
4 Indicates that the measurement data is being logged into the instrument.
5 Indicates that the alarm is set.
6 Indicates that either the [<] or [>] key can be used.
7 Indicates that either the key lock or FUNC lock is set.  If the key lock function is

on, all the keys are disabled.  In the FUNC lock state, only the temperature mea-
surement keys can be used.

See Also
For information about canceling the lock state, refer to “5 Other Useful Functions” in the “Tempera-
ture Measurement” part.

8 Indicates that the battery is almost used up.  Replace the battery as soon as
possible after this symbol is displayed.

9 Indicates that the instrument is set so that the power to the main unit will be
automatically turned off if no operation is made in a predetermined period of
time.

10 Indicates that either the [�] or [�] key can be used.
11 Indicates that the timer function is on and the instrument is in the wait state.
12 A tag name, log name, and temperature will be displayed.

[TIP]

If this instrument is used in a location where the ambient temperature is low, the characters may be
displayed slowly.  Note that this does not indicate the main unit being at a malfunction.

5  Screen (LCD) Displays
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6 How to Input Characters
This section explains the character input procedure.  Alphabets and numbers can
be entered.
The procedure used to input characters into Thermo-Collector is similar to the
method used to enter characters in a cellular phone.

� Entering characters
Use the 0  to 9  keys to enter characters.  These keys are also used to enter alphabets.
For example, the 2  key can be used to enter “A” to “C”, and “2”. To enter “C”, press the 2

key three times.
To enter “2”, press the 2  key four times.

Key

Mode

1

Alphanumeric input mode

1

A B C 2
ABC

2

DEF

GHI

JKL

MNO

PQRS

TUV

WXYZ

Symbol

3

4

5

6

7

8

9

0

D E F 3

G H I 4

J K L 5

M N O 6

P Q R S 7

9

%

T U V 8

W X Y Z

0 ! # $ )& ( =+ -

� Entering lowercase characters

1. Enter a character to be made small.

A
[ N e w T a g ]

2. Position the cursor on the character and press the [LOGGING] key.
This character is made small.

a
[ N e w T a g ]

- End of procedure

6  How to Input Characters



88

1   Overview of Preparation for Measurement

Before measuring temperatures, set the tag names, etc., on the main unit.
There are two methods for making the settings.  One is for the main unit and the
other is for a personal computer.  For efficiency, use a personal computer to set
many items.

    Setting up the main unit
    • Setting the date and time
    • Setting the name of the main unit

    Transmit the following data
   • Setup data
   • Operator name

    Measure the temperature

    Set up the following
    • Collector function
      Tag name, input channel, alarm, 
      and operator name
    • Logging function
      Log name, input channel, 
      measurement interval,
      and measurement period

Setting up the main unit Setting up the personal computer

: Setup to be performed in this part

    Set up the following
    • Collector function
      Tag name, input channel, alarm, 
      and operator name
    • Logging function
      Log name, input channel, 
      measurement interval, 
      and measurement period

1 Overview of Preparation for Measurement
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2  Setting Up the Main Unit
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2 Setting Up the Main Unit

2.1 Setting the date and time

Home screen

18:54:27
22222225.9°C

[TIP]

This screen which displays the current time is
referred to as the “Home” screen.  All the func-
tions in the main unit are accessed from this
screen.

1. Press the [FUNC], [6], and [1] keys, in
this order.
The “Time setting” screen will appear on the LCD.

F61
ClockSe t

2. Press the [SET] key.
A screen for setting the date will appear on the LCD.

Date
9 8 / 1 1 / 1 1

3. Enter the date.

See Also
For information about entering a character or
number, refer to “6  How to Input Characters”
in the “Information Required before Use” part.

4. Press the [SET] key.
A screen for setting the time will appear on the LCD.

Time
1 8 : 5 6 : 1 4

5. Enter the time.

6. Press the [SET] key.
The specified time is set.

F61
ClockSe t

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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2.2 Setting the name of the
main unit

If more than one Thermo-Collector is used
at a time, a unique name must be set for each.

[TIP]

Make this setting as necessary.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [9], and [7] keys, in
this order.
The “Name” screen appears on the LCD.

F97
Name

2. Press the [SET] key.

DevName
Name00---

3. Enter the name of the instrument (Ex-
ample: NO1).

DevNamee
NO1

See Also
For information about entering a character or
number, refer to “6  How to Input Characters”
in the “ Information Required before Use” part.

4. Press the [SET] key.
The instrument name is set.
The “Name” screen will be restored.

F97
Name

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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3 Setting Up with the Main Unit

3.1 Setups required to use the collector function
(Setting the tag name, input channel, alarm, and operator name)

Before using the collector function, the following tag setups must be made.

� Setup contents

�Tag name
Put a title for each tag.

� Input channel
Thermo-Collector has multiple input channels and probes for measuring temperatures of
substances in a vapor, solid, or liquid phase.  Since the probe to be used depends on the
measuring object, it is necessary to set the available input channel on a tag in advance.
The following table shows the probe types and their corresponding input channels.

Probe type Input channel

Standard needle probe

A
High speed needle probe

Surface probe

Rounded end probe

Built-in sensor C

Emission thermo probe D

�Alarm
Set a limit temperature at which the alarm sounds.
• ON/OFF  of the upper-limit alarm and upper-limit temperature

Make the following settings to sound an alarm when the temperature rises above a preset limit.
The upper-limit temperature cannot be set if the alarm function for the upper limit is set to OFF.

Temperature

Setting the upper-limit alarm to ON and the upper-limit temperature to 70°C

70°C

: Range in which the alarm sounds.
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• ON/OFF of the lower-limit alarm and lower-limit temperature
Make the following settings to sound an alarm if the temperature falls below a preset limit.
The lower-limit temperature cannot be set if the alarm function for the lower limit is set to OFF.

Temperature

Setting the lower-limit alarm to ON and the lower-limit temperature to 50°C

50°C

: Range in which the alarm sounds

• Inverse alarm function ON/OFF
The settings of the alarm function can be inverted.
Specifically, if this inverse alarm functions is set to ON, an alarm will sound if the temperature falls
below the upper limit or if the temperature rises above the lower limit.

Temperature

Upper-limit alarm       70°C
Lower-limit alarm       50°C

70°C

50°C

Upper-limit alarm       70°C
Lower-limit alarm       50°C

Temperature

70°C

50°C

: Range in which the alarm sounds

If “OFF” If “ON”

[TIP]

The alarm can also be set to turn off if the temperature exceeds the upper limit, or it can be set to turn
on if the temperature falls between the upper and lower limits.

�Operator name
Set the name of the operator.

See Also
For information about setting the operator name, refer to “� Registering the measurement operator
name”.
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� Creating a new tag
Create new tags for recording the measure-
ment data.

Home screen

18:54:27
22222225.9°C

1. Press the [FUNC], [1], and [3] keys, in
this order.
The “Ins” screen will appear on the LCD.

F13
Ta g I n s

2. Press the [SET] key.
A screen for selecting the tag name will appear.

Burger
0

[TIP]

If no tag has been created in the main unit,
[NewTag] is displayed on the screen.

3. Press the [�] key repeatedly until
[NewTag] is displayed on the screen.

[NewTag]
0

4. Use the [CH] key to select the input
channel.
The input channel of the [INPUT] gage changes.

[NewLog]

0

5. Press the [SET] key.
A screen for entering a new tag name will appear.

[NewTag]
[TIP]

If a new tag is created while [NewTag] is dis-
played, the created tag will be added to the end
of the list.  If the [SET] key is pressed while
[NewTag] is not displayed, the created tag will
be inserted immediately before the selected tag.

6. Enter the tag name.

[NewTag]
Convey

[TIP]

A tag name can consist of a maximum of eight
alphanumeric characters.

See Also
For information about entering a character or
number, refer to “6  How to Input Characters”
in the “ Information Required before Use” part.
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7. Press the [SET] key.
A screen for confirming the entered contents will ap-
pear.

Insert?
Yes1/No0

8. Press the [1] key.
A new tag will be created.

Convey
0

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

� Setting the alarm function for
each tag
The alarm function can be set according to
different tag conditions, or the same alarm
function can be set for all tags.
The following procedure is used to set the
alarm function for different conditions.

See Also
To set the same alarm function for all tags, pro-
ceed to “� Batch-setting the alarm function”.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [7], and [2] keys, in
this order.
The “1File” screen will appear on the LCD.

F72
1 F i l e

2. Press the [SET] key.
A screen for selecting a tag name will appear.

Convey
0

3. Press the [�] key repeatedly until a tag
name for which the alarm is to be set
appears on the screen.

4. Press the [SET] key.
A screen for setting the alarm HIGH function ON/
OFF will appear on the LCD.

Hi Alarm
ON

5. Use either the [�] or [�] key to set the
upper-limit temperature alarm function
ON/OFF.

6. If ON has been selected, press the [SET]
key.
The “Hi Alarm” setting screen will appear on the
screen.
If OFF has been selected in step 5, this screen will
not appear.  In this case proceed to step 8.

Hi Alarm
+ 0 0 0 . 0 ° C
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7. Enter the upper-limit temperature.

Hi Alarm
+ 0 2 0 . 0 ° C

[TIP]

To set a negative value, press either the [�] or
[�] key.  The “+” symbol on the screen will
change to a “-” symbol.

See Also
For information about entering a character or
number, refer to “6  How to Input Characters”
in the “ Information Required before Use” part.

8. Press the [SET] key.
The specified upper-limit temperature is set and the
screen to set the “Lo Alarm” function ON/OFF will
appear on the screen.

Lo Alarm
ON

9. Use either the [�] or [�] key to set the
lower-limit temperature alarm function
ON/OFF.

10. If “ON” has been selected, press the
[SET] key.
The “Lo Alarm” setting screen will appear on the
screen.
If “OFF” has been selected in step 9, this screen will
not appear.  In this case proceed to step 12.

Lo Alarm
+ 0 0 0 . 0 ° C

11. Enter the lower-limit temperature.

Lo Alarm
+ 0 2 0 . 0 ° C

[TIP]

To set a negative value, press either the [�] or
[�] key.  The “+” symbol on the screen will
change to a “-” symbol.

12.Press the [SET] key.
The specified lower-limit temperature is set and the
“Inverse alarm function” screen will appear on the
screen.

Turn
OFF

13.Use either the [�] or [�] key to select
whether the operation of the alarm func-
tion is to be inverted.  If ON is selected,
the alarm function will operate under the
inverse conditions.

14.Press the [SET] key.
The range in which the alarm sounds will be dis-
played.
Then, the screen for confirming the setting will ap-
pear.

Yes1/No0
Change?

15.Press the [1] key.
The alarm function will be set for each tag.

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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� Batch-setting the alarm function
The following procedure is used to set the
same alarm function for all tags.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [7], and [1] keys, in
this order.
The “All File” screen appears on the LCD.

F71
A l l F i l e

2. Press the [SET] key.
A screen for setting the alarm HIGH function ON/
OFF will appear.

Hi Alarm
ON

3. Use either the [�] or [�] key to set the
upper-limit temperature alarm function
ON/OFF.

4. If ON has been selected, press the [SET]
key.
The “Hi Alarm” setting screen will appear on the
screen.
If OFF has been selected in step 3, this screen will
not appear.  In this case proceed to step 6.

Hi Alarm
+ 0 0 0 . 0 ° C

5. Enter the upper-limit temperature.

Hi Alarm
+ 0 2 0 . 0 ° C

[TIP]

To set a negative value, press either the [�] or
[�] key.  The “+” symbol on the screen will
change to a “-” symbol.

See Also
For the method of entering a character or num-
ber, refer to “6  How to Input Characters” in
the “Information Required before Use” part.

6. Press the [SET] key.
The specified upper-limit temperature is set and the
screen of selecting ON/OFF of the “Lo Alarm” func-
tion will appear on the screen.

Lo Alarm
ON

7. Use either the [�] or [�] key to select
ON/OFF of the lower-limit temperature
alarm function.

8. When ON has been selected, press the
[SET] key.
The “Lo Alarm” setting screen will appear on the
screen.

If OFF has been selected in step 7, this screen will
not appear.  In this case proceed to step 10.

Lo Alarm
+ 0 0 0 . 0 ° C
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9. Enter the lower-limit temperature.

Lo Alarm
+ 0 2 0 . 0 ° C

[TIP]

In order to set a negative value, press either
the [�] or [�] key.  The “+” symbol on the
screen will change to a “-” symbol.

10.Press the [SET] key.
The specified lower-limit temperature is set and the
“Turn” screen will appear on the screen.

Turn
OFF

11.Use either the [�] or [�] key to select
whether the operation of the alarm func-
tion is to be inverted.  If ON is selected,
the alarm function will operate under the
inverse condition.

12. Press the [SET] key.
The range in which the alarm sounds will be displayed.
Then, the screen for confirming the settings will ap-
pear.

Change?
Yes1/No0

13.Press the [1] key.
The range in which the alarm function is active will
be set for all tags as a batch.

Press the [ESC] key repeatedly to return to the Home
screen.

[TIP]

If another alarm function is batch-set for all
tags after one alarm function has been batch-
set, only the latest one will be effective.

-End of procedure-

� Registering the measurement
operator name

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [8], and [3] keys, in
this order.

F83
E n t r y

2. Press the [SET] key.
A screen for registering an operator name will ap-
pear.

1
S m i t h

3. Press the [�] key repeatedly until a
number assigned to the operator name
to be registered appears on the screen.

2

[TIP]

Each operator name is assigned a unique reg-
istration number.  A maximum of ten operators
can be registered in the main unit.

See Also
For information about entering a character or
number, refer to “6  How to Input Characters”
in the “ Information Required before Use” part.
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4. Press the [SET] key.

5. Enter the operator name with a maxi-
mum of eight characters.

2

See Also
For information about entering a character or
number, refer to “6  How to Input Characters”
in the “ Information Required before Use” part.

6. Press the [SET] key.
The screen for confirming the settings will appear.

Entry?
Yes1/No0

7. Press the [1] key.
The specified operator name has been set.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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3.2 Setups required to use the logging function
(Setting the log name, input channel, measurement interval,
and measurement period)

Before using the logging function, it is necessary to make logs settings.

� Setup contents

�Log name
Put a title to each log.  A log name can consist of a maximum of eight alphanumeric charac-
ters.

�Input channel
Thermo-Collector is provided with multiple input channels and probes for measuring tem-
peratures of substances in a vapor, solid, or liquid phase.  Since the probe to be used de-
pends on the measuring object, it is necessary to set the available input channel on a tag in
advance.
The following table shows the probe types and their corresponding input channels.

Probe type Input channel

Standard needle probe

A
High speed needle probe

Surface probe

Rounded end probe

Built-in sensor C

Emission thermo probe D

�Measurement interval
Set an interval at which the temperature is periodically measured.  The interval can be set to
between 1 second to 24 hours.

�Measurement period
Set a period through which the temperature is measured continuously.  The period can be
set to between 1 second to 999 days.
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� Operation procedure

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [2], and [3] keys, in
this order.
The “Ins” screen will appear on the LCD.

F23
Log Ins

2. Press the [SET] key.
A screen for selecting the log name will appear.

Accept1
0

[TIP]

If no log has been created in the main unit,
[NewLog] is displayed on the screen.

3. Press the [�] key repeatedly until
[NewLog] appears on the screen.

[NewLog]

0

4. Use the [CH] key to select the input
channel.
The input channel of the [INPUT] gage changes.

[NewLog]

0

5. Press the [SET] key.
A screen for entering a new log name will appear.

[NewLog]

[TIP]

If a new log is created while [NewLog] is dis-
played, the created log will be added to the end
of the list.  If the [SET] key is pressed while
[NewLog] is not displayed, the created log will
be inserted immediately before the selected log.

6. Enter the log name.

Accept2

[NewLog]

[TIP]

A log name can consist of a maximum of eight
alphanumeric characters.

See Also
For information about entering a character or
number, refer to “6  How to Input Characters”
in the “ Information Required before Use” part.
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7. Press the [SET] key.
A screen for setting the measurement interval will appear.

Interval
0 0 : 0 0 : 1 0

8. Enter the hour, minute, and seconds.

Interval
0 1 : 1 5 : 3 0

[TIP]

The definition and range of each input value is
given below.

00:00:00
Indicates the seconds.
The input range is between 0 
and 59 seconds
Indicates the minutes.
The input range is between 0 
and 59 minutes
Indicates the hours.
The input range is between 0 
and 24 hours.

9. Press the [SET] key.
The specified measurement interval is set and the
screen for setting the measurement period (select the
number of days from the options, which also includes
the number of hours, minutes, and seconds) will be
displayed.

ProdDay
002

10. Enter the number of days.

11. Press the [SET] key.
The screen for setting the measurement period (select the
number of hours, minutes and seconds from the options,
which also includes the number of days) will be displayed.

ProdTime
0 0 : 0 0 : 0 0

12. Enter the number of hours, minutes, and
seconds.

ProdTime
0 1 : 3 0 : 0 0

[TIP]

The definition and range of each input value
are given below.

00:00:00
Indicates the seconds.
The input range is between 0 
and 59 seconds
Indicates the minutes.
The input range is between 0 
and 59 minutes
Indicates the hours.
The input range is between 0 
and 23 hours.

13. Press the [SET] key.
The screen for confirming the settings will appear.

Insert?
Yes1/No0

14. Press the [1] key.
The specified measurement period has been set.

Accept2
0

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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4 Setting Up with the Personal Computer

4.1 Setting up the “Thermo-Collector” software

The setup operation required for the main unit can be performed on a personal computer.
The “Thermo-Collector” software must be used to do this.  This section explains the proce-
dure used to set up the “Thermo-Collector” software on the personal computer.

Connecting the personal computer and the main unit
↓

Installing the “Thermo-Collector” software on the personal computer
↓

Confirming the communication environment (on the personal computer)
↓

Confirming the communication environment (on the main unit)

� Connecting the personal computer and the main unit
Purchase an RS-232C cable (Model name: 910 09, round DIN 8-pin to D-sub 25-pin type).
Follow the procedure below to connect the main unit to the personal computer.

1. Turn off the power to both the personal computer and main unit.

2. Connect the personal computer and the main unit as shown in the following diagram.

ESC FUNC SET

POWERCH LOGGING

MEMORY

ABC DEF

JKLGHI MNO

WXYZTUV

Symbol

PQRS

D

Bottom of the
main unit (8-pin)

Main unit Personal computer

Plug this cable into the connector so that the
     mark on the grip faces downward.

Serial port of the personal
computer (with 25-pin connector)

Dedicated cable (Model name: 910 09)

1 4
2 2
3 5
4 3
7 7
8 7
5, 6 (N.C.)

Connection between connector pins
(Round DIN 8-pin to D-sub 25-pin)
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[TIP]

If the personal computer has a 9-pin type serial port, a 25-pin to 9-pin conversion connector is required
(RS-232C conversion adapter, D09-9F25F (Manufacturer: Sanwa Supplies Corp.) is recommended).

3. First turn on the power to the main unit, then turn on the power to the personal com-
puter.

-End of procedure-

� Installing the “Thermo-Collector” software
Install the “Thermo-Collector” software on the personal computer.  The two floppy diskettes
that come with the main unit are required for this installation.

1. Place a floppy diskette (Setup Disk #1) in the floppy disk drive of the personal com-
puter.

2. Double-click on the “My Computer” icon.
The “My Computer” folder will be displayed.
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3. Double-click on the floppy disk drive icon (A:drive in the case of a DOS/V machine).

4. Double-click on “Setup”.
The Setup is initiated and a screen prompting the insertion of the second floppy diskette (Setup Disk #2) will appear.

5. After inserting the second floppy diskette (Setup Disk #2), click on the [OK] button.
Precautions to be observed prior to installation will appear.

6. Click on the [OK] button.
The installer of the application program is initiated and the “Thermo Collector Setup” screen will be displayed.

[Start Setup] button
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7. Click on the [Start Setup] button.

[TIP]

Do as follows to change the application install destination.
1.Click on the [Change Directory] button.
2.Select a installation destination folder.
3.Click on the [OK] button.

After installation has been completed, the following confirmation window is displayed.

8. Click on the [OK] button.

-End of procedure-

� Confirming the communication environment (on the personal computer)
Confirm the settings related to the communication environment on the personal computer.

1. Select “Thermo-Collector” in the “Programs” accessed from the “Start” menu.

2. Select “Properties” from the “Comm” menu.
The “Properties” window will be displayed.

3. Confirm that the settings are exactly as shown in the above figure.
If any of the settings are different, set them to the values given below.

Setup item Setting value
CommPort 1

Baud Rate 9600

Parity None

Data Bits 8

Stop Bits 2

[TIP]

The communication port setting values vary, depending on the type of personal computer.  For more
information, refer to the manual supplied with your personal computer.

-End of procedure-
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� Confirming the communication
environment (on the main unit)
Confirm the settings related to communica-
tion environment on the main unit.  Con-
firm that the settings are exactly as shown
in the following table.
If any of the settings are different, set them
to the values given below.

Setup item Setting value (Factory Settings)
Baud rate 9600
Parity None

Data Length 8bit

Stop bits 2bit
Flow control None

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [5], and [1] keys, in
this order.
A screen for setting the communication environment
will appear on the LCD.

F51
Comm Set

2. Press the [SET] key.
A screen for setting the baud rate will appear on the
LCD.  The displayed baud rate is 9600 bps, which is
factory setting.

Baudrate
9600

3. Press the [SET] key.
A screen for setting the parity will appear on the LCD.
The displayed parity is None, which is factory setting.

Parity
None

4. Press the [SET] key.
A screen for setting the data length will appear on the
LCD.  Confirm that the displayed data length is as
shown in the following figure.

Data Len
8 b i t

5. Press the [SET] key.
A screen for setting the number of stop bits will ap-
pear on the LCD.  The displayed number of stop bits
is 2 bits, which is factory setting.

Stop Bit
2 b i t

6. Press the [SET] key.
A screen for setting the flow control method will ap-
pear on the LCD.  The displayed flow control method
is None, which is factory setting.

Flow
None

7. Press the [SET] key.
Returns to the communication environment setup screen.

F51
Comm Set

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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4.2 Basic operation of Thermo-Collector software

This section explains the basic operation of the supplied software.

� Initiating Thermo-Collector software

Select “Thermo-Collector” in the “Programs” accessed from the “Start” menu.
After the main screen of the software is displayed, the “Setup Tags/Logs - New” screen will be displayed.
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� Terminating Thermo-Collector software

Select “Exit” from the “File” menu.

� Saving the setup data in a file

1. Select “Save” in the “Setup Tags/Logs” menu accessed from the “File” menu.
The “Save As” window will be displayed.

2. Enter a file name in the “File name” field, then click on the [Save] button.
The setup data will be saved.

-End of procedure-
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� Loading a file containing the setup data

1. Select “Open” in the “Setup Tags/Logs” menu accessed from the “File” menu.
The “Open” window will be displayed.

2. Select a file to be loaded, then click on the [Open] button.
The specified file containing the setup data will be loaded, and the tag and log setup data in the file will be displayed.

-End of procedure-
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� Saving the measurement operator name data
The operator data will be saved in a file different from that in which the tag and log data is
stored.

1. Select “Save” in the “Setup Persons” menu accessed from the “File” menu.
The “Save as” window will be displayed.

2. Enter a file name in the “File name” field, then click on the [Save] button.
The measurement operator name data being set will be saved.

-End of procedure-
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� Loading the measurement operator name file

1. Select “Open” in the “Setup Persons” menu accessed from the “File” menu.
The “Open” window will be displayed.

2. Select a file to be loaded, then click on the [Open] button.
The measurement operator name file will be loaded, and a list of operator names will be displayed.

-End of procedure-
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� Other functions (Menu functions)

“Setup Tags/Logs” submenu

Opens a file in which tags and logs have
been stored.

New

Open

Save

Save As

Send

Print

Overwrites a file in which tags and logs
have been set.

Saves a file in which tags and logs have
been set under a new file name.

Transmits the tag and log setup data to
the main unit.

Outputs the tag and log setup data for
the printer.

Creates a new setup file of tags and logs.

“Setup Persons” submenu

Outputs the operator name data for the printer.

Creates a new file for setting up operator names.
New

Open

Save

Save As

Close

Send

Print

Opens a file in which operator names have been stored.

Overwrites a file in which operator names have been set.

Saves a file in which operator names have been
set under a new file name

Closes the operator name setup screen.

Transmits the operator name data file currently
opened to the main unit.

Outputs the operator name data for the printer.

Creates a new file for setting up operator names.
New

Open

Save

Save As

Close

Send

Print

Opens a file in which operator names have been stored.

Overwrites a file in which operator names have been set.

Saves a file in which operator names have been
set under a new file name

Closes the operator name setup screen.

Transmits the operator name data file currently
opened to the main unit.

“Measured Datas” submenu
Save As
Saves the measurement data in a text format.

Close
Closes the measurement data file.

Transfer
Transfers the measurement data file to Excel.

Print
Outputs the measurement data to the printer.
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“Comm” menu
Properties
Set the conditions required to communicate with the personal
computer.  Below are the setup items
 • Communication port
 • Baud rate
 • Parity
 • Data bits
 • Stop bits

Receive
Receives from the main unit the measured temperature data and
other data set with the main unit.

“Edit” menu

Select All
Sets all the data on the currently selected box to the selected
condition.

Copy
Copies the currently selected data to the pasteboard.

Paste
Copies the data recorded in the pasteboard to the selected
location on the screen.

Delete
Deletes the currently selected data.

Cut
Moves the currently selected data to the pasteboard.

[TIP]

Measurement data received from the main unit cannot be edited using the “Edit” menu functions.

“Display” menu
Tool Bar
Switches on and off the toolbar display (button icon allowing
one-touch operation).

Status Bar
Switches on and off the status bar display (a region in which the
date and time are displayed).

“Help” menu

About Thermo Collector...
Displays the version information of the Thermo-Collector
software.
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� Other functions (Tool icons functions)
For efficiency, single-click on any of the tool icons to instantly execute the assigned function.

Creates a new setup file of tags and logs.
This function is the same as “New” in the
“Setup Tags/Logs” submenu of the “File”
menu.

Loads a file of stored tags and logs.  This
function is the same as “Open” in the “Setup
Tags/Logs” submenu of the “File” menu.

Saves the tag and log setup data file so it
overwrites the existing file.  This function
is the same as “Save” in the “Setup Tags/
Logs” submenu of the “File” menu.

Transmits the tag and log setup data cur-
rently selected to the main unit.  This func-
tion is the same as “Send” in the “Setup
Tags/Logs” submenu of the “File” menu.

Creates a new file for setting operator
names.  This function is the same as “New”
in the “Setup Persons” submenu of the
“File” menu.

Loads the operator name file that has been
saved.  This function is the same as “Open”
in the “Setup Persons” submenu of the
“File” menu.

Saves the operator name file so it overwrites
the existing file.  This function is the same
as “Save” in the “Setup Persons” submenu
of the “File” menu.

Transmits the operator name data currently
displayed on the screen to the main unit.
This function is the same as “Send” in the
“Setup Persons” submenu of the “File”
menu.

Saves the measured data in a text format file.
This function is the same as “Save As” in
the “Measured Datas” submenu of the “File”
menu.

Transfers the measurement data which is
going to the personal computer to Microsoft
Excel.  This function is the same as “Trans-
fer” in the “Measured Datas” submenu of
the “File” menu.

Outputs the measurement data received in
association with the specified tag and log
to the printer.  This function is the same as
“Print” in the “Measured Datas” submenu
of the “Comm” menu.

Receives the data from the main unit.  This
function is the same as “Receive” in the
“Comm” menu.

Moves the currently selected data to the
pasteboard.  This function is the same as
“Cut” in the “Edit” menu.

Copies the currently selected data to the
pasteboard.  This function is the same as
“Copy” in the “Edit” menu.

Copies the data recorded in the pasteboard
to the currently selected location on the
screen.  This function is the same as “Paste”
in the “Edit” menu.
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4.3 Setups required to use the collector function
(Setting the tag name, input channel, alarm, and operator
name)

Make tag settings before using the collector function.

� Setup contents

See Also
For information about each setup item, refer to “3.1 Setups required to use the collector function
(Setting the tag name, input channel, alarm, and operator name)”.

• Tag name
• Input channel
• Alarm
• Operator name

� Setting tags
1. Initiate the “Thermo-Collector” software.

After the main screen of the “Thermo-Collector” software has been displayed, the “Setup Tags/Logs - New” screen
will appear.

2. Enter the tag name in the “Name” field with a maximum of eight alphanumeric charac-
ters (Example: Burger).

[TIP]

A piece of setup data with an empty “Name” field cannot be transmitted to the main unit.  Always enter
a name for setup data to be transmitted.
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3. Double-click in the “Channel” column.
The specified tag name is set and the pull-down menu will appear.

4. Select either A, C, or D.
The specified channel is set.

5. Click in the “Hi Temperature” column
The cursor moves to a cell for the “Hi Temperature”.

6. Enter the “Hi Temperature” with numeric characters (-999.9 to +999.9; Example: +091.0).

[TIP]

Enter a value that does not exceed “Hi temperature” of the probe used for actual measurement.  The
“Hi Temperature” that can be measured varies according to the probe used for measurement.

The specified upper-limit temperature has been set.
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7. Double-click in the “Hi Alarm” column.
The pull-down menu will appear.

8. Select either ON or OFF.

9. Click in the “Lo Temperature” column.
The upper-limit alarm ON/OFF setting is made and the cursor moves to the “Lo Temperature” column.

10. Enter the “Lo Temperature” with numeric characters (-999.9 to +999.9; Example: +021.0).

[TIP]

Enter a value that does not fall below the “Lo Temperature” of the probe used for the actual measure-
ment.  The “Lo Temperature” that can be measured varies according to the probe used for the measure-
ment.

The specified lower-limit temperature has been set.

11. Double-click in the “Lo Alarm” column.
The pull-down menu will appear.
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12. Select either ON or OFF.
The lower-limit alarm ON/OFF setting is made.

13. Click in the “Turn Alarm” column.
The pull-down menu will appear.

14. Select either ON or OFF.
The alarm condition is set.

If multiple tags have to be set, select the “Name” field in the next line, then repeat  steps 2 through 14.

Subsequently, set the operator name.

-End of procedure-
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� Setting the measurement operator name

1. Select “New” from the “Setup Persons” submenu of the “File” menu.
A box for setting the Person name will appear.

2. In the “Person” field, enter the operator name with a maximum of eight alphanumeric
characters (Example: Smith).

3. Click in the “Person” field on the next line.
The Persons name is set.

If multiple Person names have to be set, select the next line and repeat steps 1 through 3.

-End of procedure-
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4.4 Setups required to use the logging function
(Setting the log name, input channel, measurement interval,
and measurement period)

Settings relating to the logging function must be made here.

� Setup contents

See Also
For more information about each setup item, refer to “3.2 Setups required to use the logging  function
(Setting the log name, input channel, measurement interval, and measurement period)”.

• Log name
• Input channel
• Measurement interval
• Measurement period

� Operation procedure

1. Double-click on the “Logs” tab.
The log file setup screen will appear.

2. In the “Name” field, enter the tag name using a maximum of eight alphanumeric char-
acters (Example: Convey).
The specified log name is set

[TIP]

A piece of setup data with an empty “Name” field cannot be transmitted to the main unit.  Always enter
a name for setup data to be transmitted.
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3. Double-click in the “Channel” column.
The pull-down menu will appear.

4. Select either A, C, or D.
The specified channel is set.

5. Click in the “Measuring interval” column.
The cursor moves to a cell for the measurement interval.

6. Enter the measurement interval with numeric characters and colons “:”  (Example:
00:10:00).

[TIP]

Use numeric characters and colons to enter a measurement interval.  The input range is: hh < 25, mm
< 60, and ss < 60, where “hh” denotes hours, “mm” denotes minutes, and “ss” denotes seconds.
All the interval data must be eight characters or less (i.e. “hh:mm:ss”. h, m, and s are optional numeric
characters).

The specified measurement interval has been set.
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7. Click in the “Measuring period” column.
The cursor moves to a “Measuring period” field.

8. Enter the measurement period with numeric characters, a backslash, and colons
(Example: 003/20:30:00).

[TIP]

Use numeric characters, a backslash, and colons to enter a measurement period.  The input range is:
ddd < 1000, hh < 24, mm < 60, and ss < 60, where “ddd” denotes the number of days, “hh” denotes
hours, “mm” denotes minutes, and “ss” denotes seconds.
All the period data must be twelve characters or less (i.e. “ddd:hh:mm:ss”. d, h, m, and s are optional
numeric characters).

The specified measurement period has been set.

If multiple tags have to be set, select a “Name” cell from the next line, then repeat  steps 2 through 8.

-End of procedure-
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4.5 Transmitting the setup data to the main unit

If the setup operation for the personal computer has been completed, transmit the setup data
of the tag, log, and operator name to the main unit.
Tag setup data and log setup data will be transmitted in a batch and as one file.  The operator
data will be transmitted separately.

NOTE

If the setup data is transmitted to the main unit, the setup data and measurement data
that existed in the main unit before transmission will be deleted.

� Preparation for transmission

1. Confirm that the power to the personal computer and main unit is OFF.

2. Connect the personal computer and main unit with the supplied cable.

See Also
For information about connecting the personal computer and main unit, refer to “� Connecting the
personal computer and main unit” in section 4.1.

3. Turn on the power of the main unit.

See Also
For information about turning on the power to the main unit, refer to “4 Turn ON/OFF of the Power
Supply” in the “Information Required before Use” part.

4. Turn on the power of the personal computer.
Now it is ready for transmission.

-End of procedure-
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� Transmitting the tag and log setup data to the personal computer

1. Initiate Thermo-Collector software.
After the main screen of Thermo-Collector software has been displayed, the “Setup Tags/Logs - New” screen will be
displayed.

2. Load a file in which the tag and log setup data is stored.

See Also
For information about loading a file containing tag and log data, refer to “� Loading a file containing
the setup data” in section 4.2.

3. Select “Send” in the “Setup Tags/Logs” submenu accessed from the “File” menu.
The confirmation dialog box will appear.
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4. Click on the [OK] button.
A dialog box indicating the progress of data transmission will be displayed.  At the same time, “Sending...” is
displayed on the main unit.

After the transmission of the tag and log setup data has been completed, the screen indicating the progress of data
transmission and the screen displaying the “Comm...” message on the main unit will disappear.

-End of procedure-

� Transmitting the measurement operator name data

1. Load a file in which the operator name to be transmitted is stored.

See Also
For information about loading a file containing operator names, refer to “� Loading a file containing
the setup data” in section 4.2.

2. Select “Send” in the “Setup Persons” menu accessed from the “File” menu.
A dialog box indicating the progress of transmission will be displayed.
At the same time, “Comm...” is displayed on the main unit.

After the transmission of the operator data has been completed, the screen indicating the progress of data transmis-
sion and the screen displaying the “Comm...” message on the main unit will disappear.

-End of procedure-
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5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

5.1 Confirming the number of
pieces of tag data

This section explains the procedure for con-
firming the number of pieces of tag data.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [1], and [1] keys, in
this order.
The “Curr tag” screen appears on the LCD.

F11
Curr Tag

2. Press the [SET] key.

Burger
12

3. Press the [�] key repeatedly until the tag to
be confirmed is displayed on the screen.
The tag name and the measurement data recorded in
association with the tag will be displayed.

Beef
5

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.2 Modifying the tag name

This section explains the procedure for modi-
fying the tag name.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [1], and [2] keys, in
this order.
The “TagChnge” screen appears on the LCD.

F12
TagChnge

2. Press the [SET] key.

Burger
12

3. Press the [�] key repeatedly until the
tag to be modified is displayed on the
screen.

Beef
5

4. Use the [CH] key to select the input
channel.
The input channel of the [INPUT] gage is modified.
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5. Press the [SET] key.

Beef
5

6. Enter a new tag name to be modified.

Pork
5

[TIP]

A tag name that has not been modified will be
displayed.  If it needs to be modified, overwrite
it with a new tag name.

See Also
For information about entering a character or
number, refer to “6  How to Input Characters”
in the “ Information Required before Use” part.

7. Press the [SET] key.
The confirmation dialog box will appear.

Change?
Yes1/No0

8. Press the [1] key.
The tag name after modification will be displayed.

Pork
5

The tag name has been modified.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.3 Clearing the measurement
data associated with the tag

This section explains the procedure used to
clear the measurement data obtained with the
collector function.  However, the setup data
(tag name) will not be cleared.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [4], and [1] keys, in
this order.
The “1TagFile” screen appears on the LCD.

F41
1 Ta g F i l e

2. Press the [SET] key.

Burger
12

3. Press the [�] key repeatedly until a tag
with measurement data that is to be
cleared is displayed on the screen.

Chicken
27

4. Press the [SET] key.
The confirmation dialog box will appear.

TagClr?
Yes1/No0
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5. Press the [1] key.

Chicken
0

All the measurement data of the selected tag will be
cleared.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.4 Deleting the tag

This section explains the procedure used to
delete the tag from the main unit.

Note

Before deleting the tag, save the mea-
surement data associated with the tag
to a personal computer, etc.
Once the tag has been deleted, all the
measurement data associated with the
tag will be completely lost.

See Also
For information about the procedure used to
save the measurement data, refer to “1  Receiv-
ing the Data on the Personal Computer” in the
“Utilizing the Measurement Data” part.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [1], and [4] keys, in
this order.
The “Tag Del” screen appears on the LCD.

F14
Tag Del

2. Press the [SET] key.

Burger
12

3. Press the [�] key repeatedly until the
tag to be deleted is displayed on the
screen.

Chicken
0

4. Press the [SET] key.
The confirmation dialog box will appear.

Delete?
Yes1/No0

5. Press the [1] key.
The selected tag and its associated measurement data
will be deleted.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5.5 Confirming the log setup
data

This section explains the procedure used to
confirm the log setup data.

Home screen

18:54:27
22222225.9°C

1. Press the [FUNC], [2], and [1] keys, in
this order.
The “Curr Log” screen appears on the LCD.

F21
Curr Log

2. Press the [SET] key.

Convey
12

3. Press the [�] key repeatedly until the
log to be confirmed is displayed on the
screen.

Accept
0

4. Press the [SET] key.
The current interval will be displayed.

Interval
0 0 : 0 0 : 1 0

5. Press the [SET] key.
The current period (the number of days selected from
the options, including also the number of hours, min-
utes, and seconds) will be displayed.

ProdDay
2

6. Press the [SET] key.
The current period (the number of hours, minutes,
and seconds from the options including also the num-
ber of days) will be displayed.

ProdTime
0 0 : 0 0 : 3 0

[TIP]

If the [SET] key is pressed, the screen used to
confirm the interval set in step 4 is restored.

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.6 Modifying the log name
and setup data (measure-
ment interval and period)

This section explains the procedure used to
modify the log name, measurement interval,
and measurement period.

Home screen

18:54:27
22225.9°C
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1. Press the [FUNC], [2], and [2] keys, in
this order.
The “LogChnge” screen appears on the LCD.

F22
LogChnge

2. Press the [SET] key.
A screen for selecting a log will be displayed.

Convey
12

3. Press the [�] key repeatedly until the
log to be modified is displayed on the
screen.

Accept
0

4. Use the [CH] key to select the input
channel.
The input channel of the [INPUT] gage is modified.

5. Press the [SET] key.
A screen for modifying the log name will be dis-
played.

Accept
0

6. Enter a new log name to be modified.

Carry
0

[TIP]

• A log name can consist of a maximum of
eight alphanumeric characters.

• A tag name that has not been modified is
displayed on the screen.  If it needs to be
modified, overwrite it with a new tag name.

See Also
For information about entering a character or
number, refer to “6  How to Input Characters”
in the “ Information Required before Use” part.

7. Press the [SET] key.
A screen for modifying the measurement interval will
appear.

Interval
0 0 : 0 0 : 1 0

8. Enter the hours, minutes, and seconds.

Interval
0 0 : 0 0 : 3 0

[TIP]

The definition and range of each input value is
given below.

00:00:00
Indicates the seconds.
The input range is between 0 
and 59 seconds
Indicates the minutes.
The input range is between 0 
and 59 minutes
Indicates the hours.
The input range is between 0 
and 24 hours.
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9. Press the [SET] key.
The measurement interval is modified and a screen for
modifying the measurement period (the number of days
from the options, which also includes the number of
hours, minutes, and seconds) will be displayed.

ProdDay
000

10. Enter the number of days.

[TIP]

Between 0 and 999 days can be inputted.

11. Press the [SET] key.
A screen for modifying the measurement period (the
number of hours, minutes, and seconds from the op-
tions, which also includes the number of days) will
be displayed.

ProdTime
0 0 : 0 0 : 3 0

12. Enter the number of hours, minutes, and
seconds.

ProdTime
0 0 : 0 0 : 4 5

[TIP]

The definition and range of each input value is
given below.

00:00:00
Indicates the seconds.
The input range is between 0 
and 59 seconds
Indicates the minutes.
The input range is between 0 
and 59 minutes
Indicates the hours.
The input range is between 0 
and 23 hours.

13. Press the [SET] key.
The confirmation dialog box will appear.

Change?
Yes1/No0

14. Press the [1] key.
The measurement period has been set.

Carry
0

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5.7 Clearing the measurement
data associated with the log

This section explains the procedure for clear-
ing the measurement data obtained with the
logging function.  However, the setup data
(log name, measurement interval, and mea-
surement period) will not be cleared.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [4], and [2] keys, in
this order.
The “1LogFile” screen appears on the LCD.

F42
1 L o g F i l e

2. Press the [SET] key.

Convey
12

3. Press the [�] key repeatedly until a log
with measurement data that is to be
cleared is displayed on the screen.

Accept
3

4. Press the [SET] key.
The confirmation dialog box will appear.

LogClr?

Yes1/No0

5. Press the [1] key.

Accept
0

All the measurement data of the selected log will be
cleared.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.8 Deleting the log

This section explains the procedure used to
delete the log from the main unit.

Note

Before deleting the log, save the mea-
surement data associated with the log
to a personal computer, etc.
If the log has already been deleted, all
the measurement data associated with
the log will be completely lost.

See Also
For information about the procedure used to
save the measurement data, refer to “1  Receiv-
ing the Data on the Personal Computer” in the
“Utilizing the Measurement Data” part.

Home screen

18:54:27
22225.9°C
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1. Press the [FUNC], [2], and [4] keys, in
this order.
The “Log Del” screen appears on the LCD.

F24
Log Del

2. Press the [SET] key.

Convey
12

3. Press the [�] key repeatedly until the
log to be deleted is displayed on the
screen.

Accept
0

4. Press the [SET] key.
The confirmation dialog box will appear.

Delete?
Yes1/No0

5. Press the [1] key.
The selected log and its associated measurement data
will be deleted.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.9 Batch-clearing the mea-
surement data associated
with both the tag and log

This section explains the procedure used to
clear all the measurement data associated
with both the tag and log.  However, note
that the setup data will not be cleared.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [4], and [4] keys, in
this order.
The “All File” screen appears on the LCD.

F44
A l l F i l e

2. Press the [SET] key.

DataClr?
Yes1/No0

3. Press the [1] key.
All the measurement data recorded in the main unit
will be cleared.
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5.10 Initializing the main unit

This section explains the procedure used to
initialize the main unit.

Note

Before initializing the main unit, it is rec-
ommended to save the setup data and
measurement data in the main unit to a
personal computer, etc.
When the main unit is initialized, all the
setup data and measurement data re-
corded in the main unit will be lost.  How-
ever, the instrument name, chime setup,
and time setup data will not be erased.

See Also
For information about the procedure used to
save the measurement data, refer to “1  Receiv-
ing the Data on the Personal Computer” in the
“Utilizing the Measurement Data” part.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [0], and [1] keys, in
this order.
The “Initial” screen appears on the LCD.

F01
I n i t i a l

2. Press the [SET] key.

I n i t i a l ?
Yes1/No0

3. Press the [1] key.
The initialization process begins.

I n i t i a · ·

In two minutes, all the data set in the main unit will be
erased and the “Initial” screen will be restored,
Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.11 Confirming the current op-
erator name

This section explains the procedure used to
confirm the operator name currently set.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [8], and [1] keys, in
this order.
The “CurrData” screen appears on the LCD.

F81
Cur rDa ta

2. Press the [SET] key.
The operator name currently set will be displayed.

1
S m i t h

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5.12 Modifying the operator

This section explains the procedure used to
switch the currently set operator.

Home screen

18:54:27
22222225.9°C

1. Press the [FUNC], [8], and [2] keys, in
this order.
The “Change” screen appears on the LCD.

F82
Change

2. Press the [SET] key.
A screen for modifying the operator will be displayed.

1
S m i t h

3. Press the [�] key repeatedly until the
operator to be modified is displayed on
the screen.
Operator names assigned to numbers between 1 and
10 will be sequentially displayed.

2
W h i t e

4. Press the [SET] key.
The operator set on the main unit will be changed.

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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When measuring temperatures with Thermo-Collector, it is necessary to use an
appropriate input channel and probe.  By combining these items in different ways,
it is possible to measure the temperature of various objects.  The temperature of
air (gases), the surface and center of a solid, and various types of liquids can be
measured.
For example, the “C” input channel (built-in sensor of the main unit) is used to
measure the ambient air temperature.  To measure the temperature at the center
of a hamburger, connect a needle-type standard probe to the “A” measuring chan-
nel.  To measure the surface temperature of a steel plate, connect a radiation
temperature probe to the “D” input channel.
The following table shows the available probe types, their corresponding input
channels, and the positions of connection jacks.

Probe (option) type Input channel Position of connection jack
Standard needle probe (Model name: 900 01)

A Left side of the top face (position marked “A” on the cover)High speed needle probe (Model name: 900 11)

Surface probe (Model name: 900 12)

Rounded end probe (Model name: 900 13)

Built-in sensor C Built into the main unit

Emission thermo probe (Model name: 900 03) D Left side of the bottom face (position marked “D” on the cover)

Warning

Do not point the tip of a needle-type standard probe or needle-type high-speed probe
towards somebody.  The needle tip is very sharp and can cause injury.

Caution

• Handle the needle-type standard probe and needle-type high-speed probe carefully
so that its stylus is only put into the intended measuring object.

• Do not use this instrument in a location where it may be splashed or dropped in
water, otherwise it may malfunction.

1 Input Channel and Probe

1 Input Channel and Probe
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ESC FUNC SET

POWERCH LOGGING

MEMORY

ABC DEF

JKLGHI MNO

WXYZYUV

Symbol

PQRS

Needle-type standard probe

An example of the needle-type standard probe connected to input channel “A”

Note

Only connect a probe to input channel “A” if the power to the main unit is off or if the
home screen is being displayed.  If the probe is connected to the channel after a tag
has been selected, this instrument may start having data logged into it the moment the
connection is made.

ESC FUNC

CLEAR

SET

POWERCH LOGGING

MEMORY

ABC DEF

JKLGHI MNO

WXYZYUV

Symbol

PQRS

Built-in sensor

ESC FUNC SET

POWERCH LOGGING

MEMORY

CLEAR

ABC DEF

JKLGHI MNO

WXYZYUV

Symbol

PQRS

xxxxxx
xxxxxxxxxxxx

POINTER MEASURE

Radiation temperature probe

Position of input channel “C” An example of the radiation temperature probe connected to input channel “D”

1 Input Channel and Probe
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2 Measuring Temperatures with the Collector Function

This section explains the procedure for measuring temperatures with the collector function.

Home screen

18:54:27
Q T D X

B

[TIP]

• This screen which indicates the current time
is referred to as the “Home” screen.  Each
function in the main unit is accessed from
this screen.

• The [0] key is also used for switching the
unit of temperature display.  If, for example,
this [0] key is pressed in the Home screen,
the unit is switched to “°F”. Another press-
ing of the same key will restore the unit to
“°C”.

1. Press the [LOGGING] key when the LOG
mark is displayed in the upper left cor-
ner of the screen.

The  LOG  mark is turned off and the
collector mode is entered.

2. If the “A” or “D” input channel is to be
used, connect the probe to the appro-
priate jack.

NOTE

Only connect a probe to input channel
“A” if the Home screen is on.  If the
probe is connected to the channel after
a tag has been selected, this instrument
may start having data logged into it the
moment the connection is made.

See Also
For information about connecting an input
channel to a probe, refer to “1  Input Channel
and Probe”.

3. Press the [�] key repeatedly until the
tag to be selected is displayed on the
screen.
The tag name currently set will be displayed.

Burger
24°C

4. If the operator name needs to be modi-
fied, press the [1] numeric key.  If not,
proceed to step 7.

[TIP]

If the operator name is not modified at this point,
the operator name assigned the registration number
“1” will automatically be set. Therefore, the factory-
setting operator name must be modified if an op-
erator other than that which is assigned the registra-
tion number “1” performs the measurement task.

1
S m i t h

A screen for modifying the operator name will be dis-
played.

5. Press the [�] key repeatedly until the
operator name to be selected is dis-
played on the screen.

2
W h i t e

2 Measuring Temperatures with the Collector Function
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6. Press the [SET] key.
The confirmation screen will appear.

Change?
Yes1/No0

7. Press the [1] key.
The operator name is modified and the previous
screen displaying the tag name is restored.

Burger
24°C

8. Press the [MEMORY] key.
A  mark is displayed in the measurement screen,
and the measurement is terminated as soon as the
buzzer sounds.  The measured value will be stored in
memory together with the current time.

Burger
24°C

The   mark will be turned off after the measure-
ment has been completed.

[TIP]

• If the [MEMORY] key is pressed when
[NewTag] is being displayed, a new tag will
automatically be created.  New tags will
automatically be assigned tag names such
as TAG01 and TAG02.

• If the measurement continues with the se-
lected tag, perform step 7 again after step 8
has been performed.  With 50 tags, a total
of 5,000 pieces of data can be recorded.

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

2 Measuring Temperatures with the Collector Function
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3 Measuring Temperatures with the Logging Function

If a log has measured data remaining in it, it is not possible to record new mea-
surement data additionally on the same log.  To record new data in the log, it must
be cleared beforehand.

[TIP]

The [0] key is also used for switching the unit
of temperature display.  If, for example, this
[0] key is pressed in the Home screen, the unit
is switched to “°F”. Another pressing of the
same key will restore the unit to “°C”.

See Also
For information about clearing the measured
data in a log, refer to “5.7 Clearing the mea-
surement data associated with the log” in the
“Preparation for Measurement” part.

Home screen

18:54:27
Q T D X

B

1. Press the [LOGGING] key when the  LOG
mark is not displayed in the upper left
corner of the screen.
The  LOG  mark is turned on and the logging mode
is entered.

18:54:42
25.9°C

2. If the “A” or “D” input channel is to be
used, connect the probe to the appro-
priate jack.

Note

Only connect a probe to input channel
“A” if the Home screen is on.  If the
probe is connected to the channel after
a tag has been selected, this instrument
may start having data logged into it the
moment the connection is made.

See Also
For information about connecting an input
channel and a probe, refer to “1  Input Channel
and Probe”.

3. Press the [�] key repeatedly until the
log to be selected is displayed on the
screen.
The log name currently set will be displayed.

Carry
24°C

4. Press the [MEMORY] key.
The interval at which the temperature measurement
is performed will be displayed.

Interval
0 0 : 0 0 : 1 0

3 Measuring Temperatures with the Logging Function
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5. Press the [MEMORY] key again.
Measurement begins.  During measurement the 
mark is displayed in the lower left corner of the
screen.

00:00:07
24°C

[TIP]

• During measurement the number of days
or time elapsed can be confirmed with the
[�] key or [�] key.

• If the [MEMORY] key is pressed when
[NewTag] is being displayed, a new tag
will automatically be created.  New tags
will automatically be assigned tag names
such as TAG01 and TAG02.

• To stop the measurement, hold down
the [ESC] key for about two seconds.

If the measurement has been completed, the previ-
ous screen displaying the log name will be restored.

Carry
24°C

Press the [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

3 Measuring Temperatures with the Logging Function
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The measurement accuracy of the radiation temperature probe(Model name:900
03) is not reliable below the decimal point.  Therefore, before making a tempera-
ture measurement with the radiation temperature probe, set this instrument so
that it does not display a fraction of a temperature in the screen of the main unit.
The radiation temperature probe, however, can be used with this instrument to
measure temperatures without performing the following setups, but, if this is done,
the accuracy of the decimal in the temperature measurement cannot be guaran-
teed.

� Switching on/off the decimal
portion of the temperature display

Home screen

18:54:27
Q T D0

B

1. Press the [FUNC], [9], and [3] keys, in
this order.
The “Digit” screen will appear on the LCD.

F93
D i g i t

2. Press the [SET] key.
A screen for switching on/off the decimal portion of
the temperature display will be displayed.

Digit
0 . 1 ° C

3. Press the [�] key.
The decimal portion of the display will be turned off.

Digit
1°C

[TIP]

Each time the [�] key is pressed, the decimal
portion of the temperature is toggled on/off.

4. Press the [SET] key.
The decimal portion of the temperature will no longer
be displayed.

F93
D i g i t

5. Press the [ESC] key three times.
The time display screen (i.e. Home screen) is restored.

18:54:57
25°C

-End of procedure-

4 Measuring Temperatures with the Radiation Temperature Probe

4 Measuring Temperatures with the Radiation Temperature Probe
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� Measuring with the radiation temperature probe

Warning

Do not look into the laser beam which is emitted from the radiation temperature probe.
The laser can cause eye damage and other injuries.

Note

Before using the radiation temperature probe, read the instruction manual supplied
with the radiation temperature probe.

1. Connect the “D” channel jack on the main unit and the radiation temperature probe.

[TIP]

• Insert the connector plug so that the “←” mark on the cable grip faces upward.

• The “D” channel connection jack is located on the left side of the main unit bottom face.

 Measuring in the collector mode

2. Set the main unit to the collector mode, then select a tag and operator name for the
measurement.

See Also
For more information about the collector mode, refer to “2  Measuring Temperatures with the Collec-
tor Function”.

3. Turn the radiation temperature probe towards the measuring object, and press the
[MEASURE] key.
A laser beam will be emitted from the radiation temperature probe and onto the measuring object.

[TIP]

If the laser beam is not being emitted, press the [POINTER] key on the radiation temperature probe.

4. While holding down the [MEASURE] key, press the [MEMORY] key on the main unit.
The temperature being displayed on the radiation temperature probe screen will also be displayed on the screen of
the main unit.  When the buzzer sounds on the main unit, the measured value and current time will be stored in
memory.

[TIP]

If the measurement continues with the selected tag, perform step 3 again after step 4 has been per-
formed.

-End of procedure-

4 Measuring Temperatures with the Radiation Temperature Probe
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 Measuring in the logging mode

2. Set the main unit to the logging mode, then select a log for the measurement.

See Also
For more information about the logging mode, refer to “3  Measuring Temperatures with the Logging
Function”.

3. While holding down the [MEASURE] key, turn the radiation temperature probe towards
the measuring object.
A laser beam will be emitted from the radiation temperature probe and onto the measuring object.

[TIP]

If the laser beam is not being emitted, press the [POINTER] key of the radiation temperature probe.

4. Press the [MEMORY] key twice.
Measurement begins.

[TIP]

To stop the measurement, hold down the [ESC] key for about two seconds.

After the specified measurement period elapses, the previous screen displaying the log name will be restored.

5. Hold down the [MEASURE] key on the radiation temperature probe until the measure-
ment has been completed.

-End of procedure-

4 Measuring Temperatures with the Radiation Temperature Probe
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5 Other Useful Functions

� To instantly clear the measured data on the main unit
There is a function on the main unit to clear the recorded measurement data.
If the measured data recorded in the main unit is not required anymore or if it needs to be
cleared instantly, use this function.

1. Bring up the Home screen.

2. Press the [�] key repeatedly until the tag to be deleted is displayed.

3. Use either the [<] or [>] key to select the measured data to be deleted.

[TIP]

Press the [<] key once to bring the last piece of measured data recorded for the tag up on the screen.

The measured data is displayed.

4. Press the [FUNC] key.
The confirmation screen will appear.

5. Press the [1] key.
The measured data will be cleared.

[TIP]

If the [FUNC] key is pressed while the tag name display screen is active, all the data associated with
the currently selected tag will be cleared (this function can also be applied to logs).

-End of procedure-

� To start a measurement in the logging mode at a specified time
(timer function)
The main unit has a function (timer function) to start logging measurement at a specified
time.  This is useful to, for example, start logging measurements after one hour.

[TIP]

If the selected log has measurement data remaining in it, this timer function cannot be used.  If this is
the case, either clear the measured data from the log or select another log.

See Also
For information about clearing the measured data in a log, refer to “5.7 Clearing the measurement data
associated with the log” in the “Preparation for Measurement” part.

1. Bring up the Home screen.

2. Press the [FUNC], [2], and [5] keys, in this order.
The “Timer reserve” screen will appear.

3. Press the [SET] key.

4. Press the [�] key repeatedly until the log to record temperatures are displayed.

5. Press the [SET] key.
The measurement interval set for the selected log will be displayed.

5 Other Useful Functions
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6. Press the [SET] key.

[TIP]

It is also possible to modify the measurement interval setting before pressing the [SET] key.

7. Press the [SET] key.
The measurement period (the number of days from the options which also include the number of hours, minutes, and
seconds) will be displayed.

[TIP]

It is also possible to modify the number of days setting before pressing the [SET] key.

8. Press the [SET] key.
The measurement period (the number of hours, minutes, and seconds from the options which also includes the
number of days) will be displayed.

[TIP]

It is also possible to modify the number of hours, minutes, and seconds settings before pressing the
[SET] key.

9. Set the date (year/month/day) and time when logging starts.

10. Press the [SET] key.
The confirmation screen will appear.

11. Press the [1] key.
 The  mark and“Stand by” will be displayed in the screen, and the instrument will enter the wait state.  When the
time set in step 9 is reached, the measurement will automatically begin.

21:30:20
Stand by

[TIP]

To cancel the wait state, hold down the [ESC] key for about two seconds.

-End of procedure-

5 Other Useful Functions
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� To quickly search for a tag or log
The main unit has a function to search for a tag or log using a number as the key.
This function is useful if there are many logs and tags set in the main unit and is faster than
using the [�] key.

1. Bring up the Home screen.

2. Press the [�] key.

3. Press the [POWER] key.

4. Enter a two-digit number.

[TIP]

A two-digit number entered is displayed in the “No.” field of Thermo-Collector screen.  It is recom-
mended to make a note of which tag or log corresponds to which number.

5. Press the [SET] key.
The tag (or log) that corresponds to the entered number will be displayed on the screen.

-End of procedure-

� To record measured data if the tag or log has not been set
In addition to the function for creating a tag or log from the Function menu, the main unit has
a useful way to create them during measurement.
This is very useful when, for example, the temperature of a steel plate needs to be measured,
but a tag for that steel plate has not been set beforehand.

1. Bring up the Home screen.

2. Press the [�] key repeatedly until [NewTag] or [NewLog] appears on the screen.
[NewTag] or [NewLog] will appear on the screen.

3. Press the [MEMORY] key.
The temperature will be measured.

[TIP]

Tags (or logs) will be temporally assigned a specific name using sequential numbers (Examples: Tag01,
Tag02, Log01, Log02....).  In this case, the measurement interval for the log is automatically set to 10
seconds, and the measurement period of the log is set to 2 days.  However, these temporary tag names
and log names can be modified later as required.

See Also
For information about modifying tag or log names, refer to “5  Confirm, Modify, Clear, or Delete the
Data with the Main Unit” in the “Preparation for Measurement” part.

-End of procedure-

5 Other Useful Functions
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� To record the start time and finish time of an operation (only with the
collector function)
The main unit has a function to record the start time and finish time of measurement opera-
tion.
This is useful when, for example, creating a daily report, since the start time and finish time
can be included in Microsoft Excel files or printouts.

� Recording the start time

1. Press the [�] key repeatedly until the tag to record temperatures is displayed.

2. Press the [2] key.
The confirmation screen will appear.

3. Press the [1] key.
The start time will be recorded.

-End of procedure-

� Recording the finish time

1. Press the [3] key if selecting a tag.
The confirmation screen will appear.

2. Press the [1] key.
The finish time will be recorded.

-End of procedure-

� To restrict inputs from the panel keys (the key lock function)
The main unit has a function called the key lock function that disables all the panel keys for input.
This function is used if the main unit is used only for temperature measurement and a temperature
record does not need to be retained, or when the main unit is used as a clock.
This function can be set by pressing the [FUNC], [9], and [5] keys in this order and in the Home
screen.
While this function is active, the “Key” mark will be displayed in the upper right corner of the
screen.

[TIP]

In order to cancel this function, hold down the [ESC] key for about two seconds.

5 Other Useful Functions
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� To enable only the panel keys (yellow keys) requied for mesurement
(FUNC lock function)
The main unit has a function called the FUNC lock function that enables only the panel keys
required for measurement.  The keys used with this function are given below :
• [MEMORY]
• [�] and [�]
• [CH]
• [LOGGING]
• [POWER]
• [ESC]
• [SET]
• [>], [<], [1], [2], [3], and [0] (only if the collector function is on)
This function can also be used when the setup information on the main unit is not to be
modified due to an operation error.
This function can be set by pressing the [FUNC], [9], and [6] keys, in this order and in the
Home screen.
When this function is active, the “Key” mark will be displayed in the upper right corner of the
screen.

[TIP]

To cancel this function, hold down the [ESC] key for about two seconds.

� To automatically turn off the power supply if no operation is performed
in a specified period of time (Auto Power Off function)
The main unit has a function called Auto Power Off to automatically turn off the power if the
main unit is not used in a given period of time (5, 10, 20, or 30 minutes).
This function is useful if you forget to tun off the power.
This function can be set by pressing the [FUNC], [9], and [4] keys, in this order and in the
Home screen.
When this function is active, the “AUTO OFF” mark will be displayed in the upper right
corner of the screen.

� To determine how much more data can be recorded
The main unit has a function to display how much more measurement data can be recorded
for the tag or log on the screen.
To activate this function, press the [FUNC], [3], and [1] keys, in this order and in the Home
screen.  Press the [SET] key to display the remaining memory capacity.  If the [SET] key is
pressed again, the number of measurement data pieces that can be used with the collector
function, if selected, will be displayed.  Furthermore, if the [SET] key is pressed another
time, the number of measurement data pieces that can be used with the logging function, if
selected, will be displayed.

� To see the number of measured data pieces recorded on the tag or log
The main unit has a function to display the number of measured data pieces recorded on the
tag or log.
To activate this function, press the [FUNC], [3], and [3] keys, in this order and in the Home
screen.

5 Other Useful Functions
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� To see the average of the measured data
The main unit has a function to calculate the average of the measured data recorded on the
tags or logs.  This is useful when pieces of data have been collected and the average is re-
quired.
To activate this function, press the [FUNC], [3], and [2] keys, in this order and in the Home
screen.
Also, to obtain the maximum and minimum values, press the [FUNC], [3], and [2] keys, in
this order and in the Home screen.

� To sound a chime at the specified time (the chime function)
The main unit has a function called the chime function to sound a chime at a time specified by the
operator.  This function is similar to an alarm clock.
The chime can be made to sound so as to signal the operator to start temperature measurement.
To activate this function, press the [FUNC], [6], and [2] keys, in this order and in the Home
screen.

� To view the screen in a dark place (the backlight function)
The main unit has a backlight function, which provides a light source so that the operator can
view the screen in a dark place.  To activate this function, press the [FUNC], [9], and [1] keys,
in this order and in the Home screen.
The backlight will be turned off if no operation is performed on the main unit for about 10
seconds.

� To turn off the electronically generated sound
The main unit has a function to turn off the key operation sound and the alarm.  Use this
function if the electronically generated sound is disturbing you.
To activate this function, press the [FUNC], [9], and [2] keys, in this order and in the Home
screen.

5 Other Useful Functions
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1 Receiving the Data on the Personal Computer

This section explains the procedure used to receive data, such as measurement
data with the main unit, on the personal computer.  The following data items can
be received:

� Measured data associated with tags and logs
� Tag and log setup data
� Operator name data

Received tag and log data can be transferred to Microsoft Excel95 or Microsoft
Excel97 (hereinafter referred to as Excel) when the data is received on the per-
sonal computer.

� Preparation before reception

1. Make sure that the power to the personal computer and main unit is turned off.

2. Connect the personal computer and main unit with the supplied cable.

See Also
For information about connecting the personal computer and main unit, refer to “� Connecting the
personal computer and the main unit” in section 4.1 of the “Preparation for Measurement” part.

3. Turn on the power to the main unit.

See Also
For information about turning on the main unit, refer to “� Turn the power supply to ON” in section 4
of the “Information Required before Use” part.

4. Turn on the power to the main unit.
Now it is ready for reception.

-End of procedure-

1  Receiving the Data on the Personal Computer
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� Receiving the data
1. Initiate Thermo-Collector software.

The main screen of Thermo-Collector software eill be displayed.

2. Select “Receive” from the “Comm” menu.
A screen for selecting the data to be received will be displayed.

3. Select the data to be received.

[TIP]

The following data items can be received

• Measured Datas ........ Measured data obtained with the main unit for tags and logs

• Setup Tags/Logs ....... Tags and logs setup data recorded in the main unit

• Setup Persons ........... Measurement operator data

1  Receiving the Data on the Personal Computer
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4. If the received data is to be transferred to Excel, double-click on the “Transfer” tab.  If
not, proceed to step 6.
A screen for selecting to which Excel file and in which format the data is transferred will be displayed.

5. When there is a need to transfer the received measurement data to Excel, select either
"Transfer to the new file" or "Transfer to the specified file".
If "Transfer to the specified file" is selected, click on the "Browse..." tab and select the
Excel file to which the data is transferred. (It is also permitted to enter the specified file
name.)  Then, it is allowed to select "Sheet Form" for designating the data format by
which the measurement data is transferred to Excel.

6. Click on the [Start] button.
A screen showing the progress of data reception will be displayed.  “Comm...” will also be displayed on the screen
of the main unit.

When data reception has been completed, the received data will be displayed on the personal computer as follows.

If “Transfer to Excel” is selected in step 5, Excel will automatically be initiated and the received data will be
transferred to Excel.

- End of procedure

1  Receiving the Data on the Personal Computer
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This section explains the procedure to directly output the data from the main unit
to the printer (Model name: 970 10, optional).

2.1 Output preparation

Before starting output to the printer, confirm that the printer is connected to the main unit
and the setup conditions of the printer.

� Printer-main unit connection
A dedicated cable must be purchased (Model name: 910 10, round DIN 8-pin to D-sub 9-pin
straight cable) to connect the printer and this instrument.
Follow the procedure below to connect the printer and main unit.

1. Turn off the power to the printer.
The power lamp will be turned off.

2. Refer to the following figure to connect the printer to the main unit.

ESC FUNC SET

POWERCH LOGGING

MEMORY

CLEAR

ABC DEF

JKLGHI MNO

WXYZYUV

Symbol

PQRS

D

Bottom of the main unit

Main unit

Printer

Power switch On-line switch

Round DIN 8-pin to D-sub 9-pin straight cable (optional)

Printer serial port (9-pin)

- End of procedure

2 Outputting Directly from the Main Unit to the Printer

2  Outputting Directly from the Main Unit to the Printer
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� Confirming the printer setup conditions

1. While holding down the [On-line switch] on the printer, turn on the power to the printer.
The printer setup conditions will be outputted to the printer.

2. Make sure that the contents are identical to that shown in the following figure.  If they
are different, correct the setup conditions.

See Also
For information about modifying the printer setup, refer to the operation manual supplied with the
printer.

[DIP SW setting mode]

Dip SW-1
1 (OFF) : Input = Serial

3 (ON) : Auto Loading = ON
4 (OFF) : Auto LF = OFF
5 (ON) : Setting Command = Enable
6 (OFF) : Printing
7 (ON) :    Density
8 (ON) :    = 100%

2 (ON) : Printing Speed = High

Dip SW-2
1 (OFF) : Printing Columns = 80

3 (ON) : Character Select = Normal
4 (ON) : Zero = Normal
5 (ON) : International
6 (ON) :    Character
7 (ON) :    Set
8 (ON) :    = Japan

2 (ON) : User Font Back-up = ON

Dip SW-3
1 (ON) : Data Length = 8 bits

3 (ON) : Parity Condition = Odd
4 (OFF) : Busy Control = XON/XOFF
5 (OFF) : Baud
6 (ON) :    Rate
7 (ON) :    Select
8 (ON) :    = 9600 bps

2 (ON) : Parity Setting = No

3. Turn off the power to the printer.

- End of procedure

2  Outputting Directly from the Main Unit to the Printer
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2.2 Outputting the measured
data to the printer

[TIP]

Connect the main unit and the printer before
turning on the power to the printer.  If this is
not done, the measured data cannot be output-
ted to the printer.

Home screen

18:54:27
22225.9°C

1. Press the [FUNC], [5] and [2] keys, in
this order.
The “1File” screen appears on the LCD.

F52
1 F i l e

2. Press the [SET] key.

Burger
11

3. Press the [�] key repeatedly until the
tag or log to be outputted is displayed.
The tag name or log name and the number of pieces
of measured data recorded in the tag or log will be
displayed.

Convey
11

[TIP]

If the [�] key is pressed repeatedly, “NewTag”
will appear.  Existing tags will be displayed
before “NewTag” appears.  Existing logs are
displayed after “NewTag” appears.

4. Press the [SET] key.
The confirmation screen will appear.

Print?
Yes1/No0

5. Press the [1] key.
Printout is performed.

[TIP]

To output all the data recorded on the main unit,
press the [FUNC], [5], and [3] keys, in this or-
der, and then press the [SET] and [1] keys.

Press the [ESC] key repeatedly to return to the Home
screen.

- End of procedure

2  Outputting Directly from the Main Unit to the Printer
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 An output example from the printer

[Burger ] HiAlarm=+80.0 LoAlarm=+60.0

No. Date Temp. Hi

00001
98/11/12/11:37:01 56.000002
98/11/12/11:37:01 57.500003
98/11/12/11:37:02 58.500004
98/11/12/11:37:03 59.800005
98/11/12/11:37:04 61.200006
98/11/12/11:37:04 62.000007
98/11/12/11:37:05 62.000008
98/11/12/11:37:06 70.000009
98/11/12/11:37:06 75.000010
98/11/12/11:37:07 81.000011

00012
00013

98/11/12/11:37:07 82.0

OK
OK
OK
OK
OK
OK
OK
OK
OK
NG
NG

Lo Person

Smith
Smith
Smith
Smith
Smith
Smith
Smith
Smith
Smith
Smith
Smith

98/11/12/11:37:15 End Smith

NG
98/11/12/11:36:50 Start Smith

NG
NG
NG
OK

NG=No Good

OK
OK
OK
OK
OK
OK

Output example (tag)

[Convey  ] Interval=00:00:10

No. Date Temp.

00001 00/00/00/00:00:00 -10.5
00002 00/00/00/00:00:10 -10.5
00003 00/00/00/00:00:20 -11.0
00004 00/00/00/00:00:30 -12.0
00005 00/00/00/00:00:40 -11.5
00006 00/00/00/00:00:50 -11.0
00007 00/00/00/00:01:00 -11.0
00008 00/00/00/00:01:10 -10.7
00009 00/00/00/00:01:20 -10.5
00010 00/00/00/00:01:30 -11.0
00011 00/00/00/00:01:40 -12.0

Output example (log)

2  Outputting Directly from the Main Unit to the Printer



WARRANTY/DISCLAIMER
OMEGA ENGINEERING, INC. warrants this unit to be free of defects in materials and
workmanship for a period of 13 months from date of purchase. OMEGA’s Warranty adds an
additional one (1) month grace period to the normal one (1) year product warranty to cover
handling and shipping time. This ensures that OMEGA’s customers receive maximum
coverage on each product. 

If the unit malfunctions, it must be returned to the factory for evaluation. OMEGA’s Customer
Service Department will issue an Authorized Return (AR) number immediately upon phone or
written request. Upon examination by OMEGA, if the unit is found to be defective, it will be
repaired or replaced at no charge. OMEGA’s WARRANTY does not apply to defects resulting
from any action of the purchaser, including but not limited to mishandling, improper interfacing,
operation outside of design limits, improper repair, or unauthorized modification. This 
WARRANTY is VOID if the unit shows evidence of having been tampered with or shows evidence
of having been damaged as a result of excessive corrosion; or current, heat, moisture or vibra-
tion; improper specification; misapplication; misuse or other operating conditions outside of
OMEGA’s control. Components which wear are not warranted, including but not limited to
contact points, fuses, and triacs.

OMEGA is pleased to offer suggestions on the use of its various products. However, 
OMEGA neither assumes responsibility for any omissions or errors nor assumes liability
for any damages that result from the use of its products in accordance with information
provided by OMEGA, either verbal or written. OMEGA warrants only that the parts 
manufactured by it will be as specified and free of defects. OMEGA MAKES NO OTHER 
WARRANTIES OR REPRESENTATIONS OF ANY KIND WHATSOEVER, EXPRESS OR
IMPLIED, EXCEPT THAT OF TITLE, AND ALL IMPLIED WARRANTIES INCLUDING ANY
WARRANTY OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
HEREBY DISCLAIMED. LIMITATION OF LIABILITY: The remedies of purchaser set forth
herein are exclusive, and the total liability of OMEGA with respect to this order, whether
based on contract, warranty, negligence, indemnification, strict liability or otherwise, shall
not exceed the purchase price of the component upon which liability is based. In no event
shall OMEGA be liable for consequential, incidental or special damages.

CONDITIONS:  Equipment sold by OMEGA is not intended to be used, nor shall it be used: (1) as
a “Basic Component” under 10 CFR 21 (NRC), used in or with any nuclear installation or activity;
or (2) in medical applications or used on humans. Should any Product(s) be used in or with any
nuclear installation or activity, medical application, used on humans, or misused in any way,
OMEGA assumes no responsibility as set forth in our basic WARRANTY/DISCLAIMER language,
and, additionally, purchaser will indemnify OMEGA and hold OMEGA harmless from any liability
or damage whatsoever arising out of the use of the Product(s) in such a manner.

RETURN REQUESTS/INQUIRIES
Direct all warranty and repair requests/inquiries to the OMEGA Customer Service Department.
BEFORE RETURNING ANY PRODUCT(S) TO OMEGA, PURCHASER MUST OBTAIN AN
AUTHORIZED RETURN (AR) NUMBER FROM OMEGA’S CUSTOMER SERVICE DEPARTMENT
(IN ORDER TO AVOID PROCESSING DELAYS). The assigned AR number should then be
marked on the outside of the return package and on any correspondence.
The purchaser is responsible for shipping charges, freight, insurance and proper packaging to
prevent breakage in transit. 

FOR WARRANTY RETURNS, please have
the following information available BEFORE 
contacting OMEGA:
1. Purchase Order number under which 

the product was PURCHASED,
2. Model and serial number of the product

under warranty, and
3. Repair instructions and/or specific 

problems relative to the product.

FOR NON-WARRANTY REPAIRS, consult
OMEGA for current repair charges. Have the
following information available BEFORE 
contacting OMEGA:
1. Purchase Order number to cover the COST

of the repair,
2. Model and serial number of the product, and
3. Repair instructions and/or specific problems 

relative to the product.

OMEGA’s policy is to make running changes, not model changes, whenever an improvement is possible. 
This affords our customers the latest in technology and engineering.
OMEGA is a registered trademark of OMEGA ENGINEERING, INC.
© Copyright 2000 OMEGA ENGINEERING, INC. All rights reserved. This document may not be copied, photocopied,
reproduced, translated, or reduced to any electronic medium or machine-readable form, in whole or in part, without
the prior written consent of OMEGA ENGINEERING, INC.



Over 100,000 Products Available
Online at omega.com

TEMPERATURE
MU Thermocouple, RTD & Thermistor Probes, Connectors, Panels & Assemblies
MU Calibrators & Ice Point References
MU Recorders, Controllers & Process Monitors
MU Infrared Pyrometers

PRESSURE, STRAIN AND FORCE
MU Transducers & Strain Gages
MU Displacement Transducers
MU Instrumentation & Accessories

FLOW/LEVEL
MU Rotameters, Gas Mass Flowmeters & Flow Computers
MU Air Velocity Indicators
MU Turbine/Paddlewheel Systems

pH/CONDUCTIVITY
MU pH Electrodes, Testers & Accessories
MU Benchtop/Laboratory Meters
MU Controllers, Calibrators, Simulators & Pumps
MU Industrial pH & Conductivity Equipment

DATA ACQUISITION
MU Data Acquisition & Engineering Software
MU Communications-Based Acquisition Systems
MU Plug-in Cards for Apple, IBM & Compatibles
MU Recorders, Printers & Plotters

HEATERS
MU Heating Cable, Cartridge & Strip Heaters
MU Immersion & Band Heaters
MU Flexible Heaters

ENVIRONMENTAL
MONITORING AND CONTROL
MU Metering & Control Instrumentation
MU Pumps & Tubing
MU Air, Soil & Water Monitors
MU Industrial Water & Wastewater Treatment

www.omega.com
ONE OMEGA DRIVE, STAMFORD, CT  06907 USA

TEL: 1-888-TC-OMEGA
(1-888-826-6342)
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